SelectSurvey.NET Power User Training

This course covers advanced features and should follow completion of the Basic Training for the SelectSurvey application.

Contents

Course Outline ................................................................. 4

Advanced Survey Design: .......................................................... 6

  Primary Validation ................................................................. 6

  Database Dropdown Question – Database Option ................................. 10

  Database Dropdown Question – Web Service Option ..................................... 12

  Database Checkbox Question .......................................................... 16

  Database Options Question .......................................................... 16

  Matrix Database Query Capability ....................................................... 17

  Matrix Rating Scale Slider Question Type .............................................. 19

  Choice – One Answer Per Row (Icons) ................................................... 20

  Calculated Question Type .............................................................. 21

Adding HTML in question text ................................................................. 24

  How to add links to your question text ..................................................... 24

  How to add html to your question text ..................................................... 25

  How to add images to question answer options ........................................ 27

Timed and Scored Survey Design ................................................................. 28

  Timed Survey ................................................................. 28

  Scored Survey ................................................................. 29

Multiple Language Survey Design ................................................................. 31

  Language selector survey ................................................................. 31
Advanced Piping Tokens: ........................................................................................................... 32
Pre-populating a survey with email list tokens ........................................................................... 32
Pre-populating a survey with user tokens ...................................................................................... 33
Template Design ............................................................................................................................ 34
Deploying survey .......................................................................................................................... 47
Short URL Rerouting ...................................................................................................................... 47
Email List ........................................................................................................................................ 47
Email List containing survey login/password ................................................................................ 52
3rd party email deployment such as Constant Contact .................................................................. 53
Email Message Formatting .............................................................................................................. 55
Hidden Fields .................................................................................................................................. 57
Dynamic Tokens ............................................................................................................................ 58
Advanced Reporting ....................................................................................................................... 60
   Free Form Auto-PDF Population mapping into Acro Fields ...................................................... 62
Application Wide Settings Options ................................................................................................ 66
Archiving and Restoring Surveys from Archive Database .............................................................. 67
Admin Tools ..................................................................................................................................... 69
Kiosk Admin ..................................................................................................................................... 71
User Reviewers for User Workspace and Approve/Review ............................................................ 74
User Workspace ............................................................................................................................. 75
3rd Party API Integration: ................................................................................................................ 79
   Workfront Project API – Push Survey Data into new Project Issues ........................................ 79
SalesForce API ............................................................................................................................... 83
SugarCRM API .................................................................................................................................. 83
Course Outline

- Advanced Survey Design:
  - Database Dropdown Question – Populated from Database
  - Database Dropdown Question – Populated from Web Service
  - Calculated Question Type
  - Adding HTML in question text
    - How to add images to question answer options
    - How to add tooltips to question text
  - Timed and Scored Survey Design
- Advanced Piping Tokens:
  - Pre-populating a survey with email list tokens
  - Pre-populating a survey with user tokens
- Deploying survey with Email List containing survey login/password
- Deploying a survey with 3rd party email deployment such as Constant Contact
- Hidden Fields
- Dynamic Tokens
- Advanced Reporting
• Application Wide Settings Options
• Admin Tools
• Kiosk Admin
• Obtaining Technical Support Resources
Advanced Survey Design:

*Primary Validation*

Using the open ended one line question type you can add custom validation such as regex to validation or match the inputted text to a specified format.

UK zip code validation:
1) Add an open ended one line question to the survey:

2) click “Advanced Validation”
3) Choose “CORE: Regular Expression Validation” then click “GO”

4) Enter the regex per the example (use an online regex tester if you need to) Select the action from the drop down that you want to trigger the validation (when they click next in the survey (onsubmit), or when their mouse leaves the field (onblur), then click “ADD” to add the validation.
Enter the regular expression matching pattern using RegExp() constructor format.
Example 1: \d
Example 2: \d/ (see regex tester in left menu)
Example 3: ^[a-zA-Z0-9]+$ (only letters and numbers)

Regular Expression Pattern:

Specify Alert Text:

Type in the text that you want to pop up when validation fails. Note: do not use apostrophes.

Alert Text:

Select Event which will trigger this Validation:

Event:
onBlur (The input focus was lost on item)

Add

5) Click “SAVE”

Item Validation Saved Successfully.
Example 3: ^[a-zA-Z0-9]+$ (only letters and numbers)
```javascript
/^[a-zA-Z]{1,2}[0-9]{1,2}[0-9][a-zA-Z]{1,2}$\s*/
```

Specify Alert Text:
Type in the text that you want to pop up when validation fails. Note: do not use apostrophes.

Please enter a valid UK Zip Code

Select Event which will trigger this Validation:
The event is what will kick off the javascript validation.

onBlur (The input focus was lost on item)

Add

Current Validations for this Item:

Top level item validation: (Note: alternatively, you can directly edit the javascript in this box and click save.)
Example (pasting this in the below box, then click save):
onblur="this.value = this.value.toUpperCase();"
The above will change all the text in the box to upper case after the input box loses focus.
onBlur="ValidateValueRegEx(document.forms[0].QID2395.value, "^[a-zA-Z]{1,2}[0-9]{1,2}[0-9][a-zA-Z]{1,2}$\s*/
'Please enter a valid UK Zip Code');"
The database dropdown question serves as a direct database query to a lookup table to fill a drop down box.

To add a database dropdown question you will need to format a T SQL Query that returns results that can populate the dropdown box.

The query needs to be formatted specifically with “ItemValue” and “ItemDisplay”.

The “ItemValue” is the value that gets stored in the database when the respondent chooses this answer, typically the ID or identifier of the display value. The “ItemDisplay” is the value that shows in the drop down box to the respondent.

You can use any token in the query as shown in the example, or no tokens at all.

An example with a hidden field token is:
SELECT full_state AS ItemDisplay, state_abbr AS ItemValue FROM _state where full_state='###HD=LocationState###'

An example without a token is:

SELECT full_state AS ItemDisplay, state_abbr AS ItemValue FROM _state order by full_state

2. database dropdown question type.

<table>
<thead>
<tr>
<th>state_abbr</th>
<th>state_id</th>
<th>full_state</th>
</tr>
</thead>
<tbody>
<tr>
<td>KS</td>
<td>1</td>
<td>KANSAS</td>
</tr>
<tr>
<td>MO</td>
<td>2</td>
<td>MISSOURI</td>
</tr>
<tr>
<td>CO</td>
<td>3</td>
<td>COLORADO</td>
</tr>
</tbody>
</table>
**Database Dropdown Question – Web Service Option**

Choice – Database Dropdown

Below is an example of how to populate a “Database Dropdown” question type from a public or third party Soap 1.2 web service.

In order to populate a dropdown from web service you must first create a “Web Service Token” the same way you create a “Database Token”. Token creation pages can be accessed from “Admin Tools” or from the link “Manage Tokens” on the “Create/Edit Item” page in modify survey page.

Below is
Click the link “Web Service/API Tokens used in Dynamic Tokens and Database Question Types” as shown in the image above.

Click “Create Web Service Token” to create a new token.
Below is an example of a public Soap 1.2 web service that you can use to fill a “Country” drop down box with all of the available countries in it.

<table>
<thead>
<tr>
<th>Web Service Token (Nickname) Assignment</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Add Web Service/API Token (Nickname):</strong></td>
</tr>
<tr>
<td><strong>Web Service Token Nickname:</strong></td>
</tr>
<tr>
<td><strong>Example:</strong> country</td>
</tr>
<tr>
<td><strong>country</strong></td>
</tr>
<tr>
<td><strong>Web Service Name:</strong></td>
</tr>
<tr>
<td><strong>No special characters are allowed.</strong></td>
</tr>
<tr>
<td><strong>Web Service/API URL:</strong></td>
</tr>
<tr>
<td>i.e. <a href="http://your.com/yourapi.asmx">http://your.com/yourapi.asmx</a></td>
</tr>
<tr>
<td><strong><a href="http://www.webservicex.net/country.asmx">http://www.webservicex.net/country.asmx</a></strong></td>
</tr>
<tr>
<td><strong>Example:</strong> <a href="http://www.webservicex.net/country.asmx">http://www.webservicex.net/country.asmx</a></td>
</tr>
<tr>
<td><strong>Web Service/API Credentials Username:</strong></td>
</tr>
<tr>
<td><strong>Example:</strong> (leave blank)</td>
</tr>
<tr>
<td><strong>Web Service/API Credentials Password:</strong></td>
</tr>
<tr>
<td><strong>Example:</strong> (leave blank)</td>
</tr>
<tr>
<td><strong>Web Service/API Method:</strong></td>
</tr>
<tr>
<td><strong>The arguments, if any, are specified on the edit item page.</strong></td>
</tr>
<tr>
<td><strong>GetCountries</strong></td>
</tr>
<tr>
<td><strong>Example:</strong> GetCountries</td>
</tr>
<tr>
<td><strong>Web Service/API Credentials Encryption Key:</strong></td>
</tr>
<tr>
<td><strong>Must be over 8 characters long, or left empty.</strong></td>
</tr>
<tr>
<td><strong>Example:</strong> (leave blank)</td>
</tr>
</tbody>
</table>

With the settings above in the screenshot, you should be able to use this token to populate a Database Dropdown question.

On the edit item page access from the modify survey page, select the Country Token as the data source for this question. Select the radio button next to “External Web Service/API” and ignore everything under “External Database”.

Your screen should look identical to the below:
So the below dropdown question is now populating with countries:
**Database Checkbox Question**

Choice - Database Checkboxes
Entering your dynamic database query returns rows for checkbox list.

1. Select the survey:
   - [ ] EVENT RECAP FINAL 6-9-2014
   - [ ] COPY of EVENT RECAP PROXIMO - old
   - [ ] Manage Suppliers and Products Start Page for Leslie
   - [ ] Edit supplier logic - do not delete
   - [ ] Event RECAP copy - old version

**Database Options Question**

Choice – Database Options
Entering your dynamic database query returns rows for radio buttons.
Matrix Database Query Capability

What if you want to prepopulate the matrix row text from prior answers or custom data or 3rd party database? You can! You can populate matrix row text the same way you can populate a “Database Dropdown” question type. You can type in a query that populates the matrix row text and only adds the exact number of matrix rows as returned by your custom query.

Applies To Only the Below Matrix Question Types:

- Matrix – Multiple Answers Per Row (Checkboxes)
- Matrix – Multiple Answers Per Row (Text/Dropdown)

Then type in the query into the box per the example and screenshot below. Your query will be dependent on what data you are wanting to populate with. The example below populates the row text with the top 5 survey names in your survey table. Note that there are additional query examples if you click the “Help” link to view the in app help.
Enter your columns as you would normally.

Columns

Column headings and types. * Enter each of the column headings in the text boxes below and a next column. Separate values by semicolon ".;".

For Icon Question Types Only:
Icon Class (ex: fa fa-check fa-2x) choose any icons from http://fontawesome.github.io/Font Icon Color Class (can be a different class for each column so each column can have separate h Specify Colors in Survey Template CSS

Enter Your First Name

Open Ended - One Line

Enter Your Last Name

Open Ended - One Line

Select Your Location

Choice - One Answer (Dr; LocationA; LocationB)

When the survey is launched it will run the custom query in real time populating the matrix row text accordingly.
1. This demonstrates dynamic query capability of the Matrix - Multiple Answer per Row (Text/Dropdown) question type. With this question type you can type in a query that populates the row text of the matrix. This query can be based on prior answers, or query a 3rd party database, or custom table in your database.

<table>
<thead>
<tr>
<th>Enter Your First Name</th>
<th>Enter Your Last Name</th>
<th>Select Your Location</th>
</tr>
</thead>
<tbody>
<tr>
<td>decisionmaking in</td>
<td></td>
<td>-- Please Sel ▼</td>
</tr>
<tr>
<td>secondary prophylaxis</td>
<td></td>
<td></td>
</tr>
<tr>
<td>of venous</td>
<td></td>
<td></td>
</tr>
<tr>
<td>thromboembolism</td>
<td></td>
<td></td>
</tr>
<tr>
<td>test</td>
<td></td>
<td>-- Please Sel ▼</td>
</tr>
<tr>
<td>date</td>
<td></td>
<td>-- Please Sel ▼</td>
</tr>
<tr>
<td>NPS monitor</td>
<td></td>
<td>-- Please Sel ▼</td>
</tr>
<tr>
<td>TestKamil</td>
<td></td>
<td>-- Please Sel ▼</td>
</tr>
</tbody>
</table>

**Matrix Rating Scale Slider Question Type**

Matrix - Rating Scale Slider (Numeric)

Html5 slider will show for all devices that support it, for older versions of IE browser, it will render a legacy html javascript slider.
Choice – One Answer Per Row (Icons)

For any of the “Icons” question types, you can specify font awesome icons instead of checkboxes or option buttons and you can set them to highlight on rollover with your survey stylesheet.

A reference for all of the icons that you can use is here: http://fontawesome.github.io/Font-Awesome/icons/
A Calculated Question type is a question that is calculated from another question, or from tokens, or from a combination of both.

For example, a question that calculates body mass index:

Weight divided by height times height * 703.

(###133###/(###145###*###145###))*703

Click in the left blue panel “Token Reference” to see what the tokens are for the height and weight questions (or questions that you are using to calculate).

Then use those values in your calculation:
Calculated Question Type Example

Enter the question alias. Enter alternate text for use in the reports. If blank, the actual question will be displayed.

Enter the sub-text. Enter informational or additional text to display below the question.

Options

☑ Enable textbox. Check the box if you want the calculated answer textbox to be enabled. (If checked, respond

The calculated question type allows the survey to calculate values from previous numeric questions displaying the
Enter the calculation using pipe tokens to represent the question item answer values.
Example: (###12502###/###12503###*###12503###)*703
Tokens must be questions that were on previously answered pages of the survey, otherwise the values will not be

Enable rounding decimal places. Ex: 0-1, 1-1.0, 2-1.00, 3-1.000, 4-1.0000

0
The calculation shows on the calculated question type from the prior question answers:
Adding HTML in question text

*How to add links to your question text*

You can add links which open new windows or open/download reference documents that you have uploaded via the upload file tool.
How to add html to your question text

Click “Tools” > “Source Code” to view and edit the html source code.

Things you can do with this:

- Copy in video links from youtube or other sources to be viewed for answering a survey question.
- Adding paypal donate buttons/links
- Adding google maps code
contact method
How to add images to question answer options

You can enter html into any question text or answer text boxes. For example if you want the text to be bold you can do:

<b>Your text</b>

If you want one word to be colored red you can do:

<span style="color:red">This is RED text</span> and this is not.

You can also include images in answer options by putting html image tags in the answer option text.

You can also add height and alignment to your html.
Timed and Scored Survey Design

**Timed Survey**

Click “Survey Options” then click “Access” then click “Timed” and enter the maximum time for taking the survey.
On each page of the survey the top will show the time elapsed, total time, and time remaining.

When the time has been reached, the user is forwarded to the “Thank you for taking the survey” completion page.

**Scored Survey**

You can add points to any question type that has a point field.

That includes most question types, all “choice” question types, and matrix question types.
The points are stored with the responses, and are calculated on the Results Overview Report, and other reports.

### Example of Points

<table>
<thead>
<tr>
<th>Response</th>
<th>Total</th>
<th>Percent</th>
<th>Points</th>
<th>Avg</th>
</tr>
</thead>
<tbody>
<tr>
<td>Strongly Agree</td>
<td>0</td>
<td>0%</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Agree</td>
<td>1</td>
<td>100%</td>
<td>4</td>
<td>4</td>
</tr>
<tr>
<td>Neutral</td>
<td>0</td>
<td>0%</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Disagree</td>
<td>0</td>
<td>0%</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Strongly Disagree</td>
<td>0</td>
<td>0%</td>
<td>0</td>
<td>0</td>
</tr>
</tbody>
</table>

**Total Respondents (For this Question)**: 1

**Total Responses**: 1

**Total Points Earned**: 4

**Point Average**: 4

**Point Weighted Average**: 4

You can display the points to the user using any of the points tokens available:

### Score Tokens:

<table>
<thead>
<tr>
<th>TOKEN</th>
<th>SURVEY PAGE</th>
<th>ORDER QUESTION TEXT</th>
</tr>
</thead>
<tbody>
<tr>
<td><em><strong>SC=12508</strong></em></td>
<td>3</td>
<td>Example of points</td>
</tr>
</tbody>
</table>
You can display a certificate of completion at the end of the survey by pasting in the certificate html/rich text into the survey options – completion message.

### Multiple Language Survey Design

**Language selector survey**

To create a survey in multiple languages:

1. Create a survey with one page that contains a language selection drop down box (or any single select question type).

2. Create an ActiveLogic workflow with “Redirect” option for each language in the drop down. Each language would be a separate workflow with the “operator” of that question answer. Each workflow would have a “redirect” action which you would place in the survey deployment URL of the survey with that language. (see ActiveLogic guide for further instructions on how to use ActiveLogic workflows)
3) Create the English version of the survey. Make sure it is finished and exactly how you want it, for the exports to all match up, it is important not to add or remove questions after making the other language copies.

4) Create the other language surveys by clicking “Create survey” > “From Existing” then select the original English version of the survey. Copy as many times as needed, naming the survey with the language you want it to be.

5) Edit the other language surveys by going to “Survey Options” > “General” and selecting the language from the drop down box. Click “Translate” button to automatically translate all text in the survey to the other language.

6) If you need to customize any automatically translated text, check the survey text. To check the validation message translation, go to “admin tools” > “globalization/translations” for the languages that you are using. This text will show after you set the language on the survey and is used for any “rendered” text.

7) Exporting the data: Export each survey and check the checkbox next to “Response ID” and “Survey ID” so that you can combine the responses of all surveys into one spreadsheet. Make sure the export settings are the same for every export so all of the columns will line up.

8) Make sure the start and end date of all surveys are correct and the same.

Advanced Piping Tokens:

_pre-populating a survey with email list tokens_

When deploying a survey to an email list through SelectSurvey.NET you have access to all of the email list data for each recipient. Each piece of data has a token that you can put as the default value or populate the survey with. Each recipient email link has a unique URL that identifies that recipient, so you can prepopulate any of the data related to that email list.

**E-mail List Tokens:** (from email list data stored in database)

<table>
<thead>
<tr>
<th>TOKEN</th>
<th>EMAIL LIST ATTRIBUTE</th>
</tr>
</thead>
<tbody>
<tr>
<td>###ED=EMAIL_ADDRESS###</td>
<td>Email Address</td>
</tr>
<tr>
<td>###ED=FIRST_NAME###</td>
<td>First Name</td>
</tr>
<tr>
<td>###ED=LAST_NAME###</td>
<td>Last Name</td>
</tr>
<tr>
<td>###ED=CUSTOM_DATA_1###</td>
<td>Custom Data 1</td>
</tr>
<tr>
<td>###ED=CUSTOM_DATA_2###</td>
<td>Custom Data 2</td>
</tr>
<tr>
<td>###ED=CUSTOM_DATA_3###</td>
<td>Custom Data 3</td>
</tr>
</tbody>
</table>

**Piping Data Tokens:**
Pre-populating a survey with user tokens

When deploying a survey with the access type “Login Required” on the survey options page, you have access to all of the user data for each recipient. Each piece of data has a token that you can put as the default value or populate the survey with. When the user logs in to take the survey the recipient is identified and that user data can prepopulate the survey.
We provide a default template called “Responsive Template” that automatically scales to the device you are using to take the survey. In addition you can copy, edit or create as many look and feel survey templates as you like. You can use the built in template edit menus, or paste in your own custom style sheet like the below example:
1. BalloonExample tooltips example

2. Is the sky blue?
   - None

3. Example of points
   - Strongly Agree
   - Agree
   - Neutral
   - Disagree
   - Strongly Disagree

Stylesheet for the above template:

```css
/*
 * Survey Stylesheet
 */

/* CUSTOM CLASSES
----------------------------------------------- */

#head-top {
    background: #373737;
    height: 40px;
    padding-left: 3000px;
    margin-left: -3000px;
}
```
padding-left: 3000px;
margin-left: -3000px;
padding-right: 3000px;
margin-right: -3000px;
position: fixed;
bottom: 0;
}

#footer span {
  color: #f5f2ed;
  font-size: 13px;
  width: 760px;
  display: block;
  text-align: center;
}

#push {
  padding: 80px;
}

/* STANDARD CLASSES
----------------------------------------------- */

.SurveyName /*style of survey name/title that is outside of outline border*/{
  font-family:'EksjaExtremesRegular';
  -webkit-font-smoothing: antialiased;
  font-size: 28px;
  font-weight: bold;
  position: relative;
  top: 193px;
  left: 80px;
  z-index:100;
}
.SurveyBodyStyle /*style on survey body tag*/{
    margin: 0;
    overflow-x: hidden;
    font-family: 'Gudea', sans-serif;
    -webkit-font-smoothing: antialiased;
    background:url(/uploads/images/mushroom.jpg) fixed;
}

.SurveyAlignmentStyle /*outer alignment table style*/{
    position: relative;
    margin-top: 0;
    border-spacing: 0;
}

.SurveyAlignmentRowStyle /*first row in outer alignment table*/{}

.SurveyLogoBlockStyle /*outer table that contains logo*/{}

.SurveyBorder,
    table[style$="#ffffff"] /*border width and style of box that goes around survey page*/{
        position: relative;
        top: 130px;
        border: solid 1px #fff;
        padding:10px;
        margin-bottom: 80px;
        height: 100%;
        background-color: rgba(245, 242, 237, .5);
        overflow-x: hidden;
    /* Rounded Corners */
    /* Box Shadow */
        -moz-border-radius: 15px;
        border-radius: 15px;
        -moz-box-shadow: 1px 1px 10px 5px #444;
```css
-webkit-box-shadow: 1px 1px 10px 5px #444;
box-shadow: 1px 1px 10px 5px #444;
}

table[style$="#ffffff"] {background:url(/uploads/images/mushroom.jpg);}
.SurveyColor /*color of background box of survey within the survey border*/{
    background: #f3d08e;
    overflow: hidden;
    -moz-border-radius: 15px;
    border-radius: 15px;
}

table[style$="#f5f2ed"] {
    overflow: hidden;
    border: solid #f5f2ed 1px;
    -moz-border-radius: 15px;
    -webkit-border-radius: 15px;
    border-radius: 15px;
}

    table[style$="#f5f2ed"] span, table[style$="#f5f2ed"] p {
        font-family: 'Gudea', sans-serif;
        -webkit-font-smoothing: antialiased;
        font-size: 140%;
    }
}
.
.SurveyOuterProgressBarTable /*table that contains progress bar*/{background: #f3d08e;}
.SurveyTimerTable /*table that contains survey timer feature*/{
.SurveyProgressBarTextTable /*contains height and style of progress bar table*/{
.PageNumberFontStyle /*the style of the text of page numbers in progress bar and elsewhere*/{
.SurveyProgressBarTable {}
.
.ProgressFirstColor /*the color of the first progress bar color*/{background: #c34500;}
.
.ProgressSecondColor /*the color of the second progress bar color*/{background: #f5f2ed;}
```
"Save" Navigation | Save | choose | or | Save
---|---|---|---|---
"Close" Navigation | Close This W | choose | or | Close
"View Reports" | View Reports | choose | or | View Reports
"Enter Next Response" | Enter Next Res | choose | or | Enter Next Response
"Print Response" | Print Res | choose | or | Print Response
"Continue" | Continue | choose | or | Continue
"Logoff" | Logoff | choose | or | Logoff

**Stylesheet Link or Stylesheet Text**

- **Use Styled Buttons** Check this box if you want to use your stylesheet for input button styles (i.e., standard input buttons will be used with the "Link Text" as the button text). To use custom button images, do not check this box.

- **Override Styles** **WARNING!** Override styles from selections above (overides alignment, border, progress bar, fonts, colors and ALL selections above). If this is not checked, both selections above and stylesheet will be referenced in the page. You will have to specify styles for the border and progress bar, etc. if you want those to show up after clicking this checkbox to over-ride them. Reference the styles in the style reference below to correctly set them.

**Custom Stylesheet**

Paste or type in your stylesheet link or inline stylesheet into the box below which will go in the page header.

```css
/* Custom Stylesheet */
margin-left: -3000px;
padding-right: 3000px;
margin-right: -3000px;
position: absolute;
top: 0;
border-bottom: solid 4px #f5f2ed;
}

#head-main {
    position: absolute;
top: 0;
left: 0;
display: table;
width: 760px;
height: 113px;
}
#head-main {
display: table-cell;
vertical-align: bottom;
```

**Style Class Reference:** Below are the class references that are present in survey question items, and surveys automatically. You can create your own style in the box above for any of the below:
### Template Name:

**Layhna Template**

**Active:** Yes

**Public Use:** Yes

**Owners:** Enter the usernames for all owners of this survey. Separate each name with a semi-colon, and make sure that your username is in the list.

**Logo Path:** Enter the path for the logo to display at the top of the surveys. If left blank, no logo will be displayed.

**Logo Alignment:** Right

**Survey Alignment:** Center

### Borders and Colors

**Matrix Header Color:** #EFEFEF

**Matrix First Color:** #FFFFFF

**Matrix Second Color:** #F8F8FF

**Progress First Color:** #EFEFEF

**Progress Second Color:** #FFFFFF

**Survey Background Color:** #FFFFFF

**Page Background Color:** #EFEFEF

**Display Border:** Yes

**Border Width:** 2

**Border Color:** #003363

### Font Styles

<table>
<thead>
<tr>
<th>Font Color</th>
<th>Font Size</th>
<th>Font Weight</th>
<th>Font Family</th>
</tr>
</thead>
<tbody>
<tr>
<td>Survey Name</td>
<td>18</td>
<td>Bold</td>
<td>Verdana</td>
</tr>
<tr>
<td>Page Title</td>
<td>14</td>
<td>Bold</td>
<td>Verdana</td>
</tr>
<tr>
<td>Page Number</td>
<td>14</td>
<td>Normal</td>
<td>Verdana</td>
</tr>
<tr>
<td>Question Text</td>
<td>12</td>
<td>Normal</td>
<td>Verdana</td>
</tr>
<tr>
<td>Question Sub-Text</td>
<td>10</td>
<td>Normal</td>
<td>Verdana</td>
</tr>
<tr>
<td>Navigation Links</td>
<td>14</td>
<td>Normal</td>
<td>Verdana</td>
</tr>
<tr>
<td>Matrix Header</td>
<td>12</td>
<td>Bold</td>
<td>Verdana</td>
</tr>
<tr>
<td>Page Introduction</td>
<td>12</td>
<td>Bold</td>
<td>Verdana</td>
</tr>
</tbody>
</table>
Deploying survey

*Short URL Rerouting*

For a shortened URL there is a built in URL rewriter on the deploy survey page:


**URL Rewriter**

Create a clean short URL.

**Example:**

http://yoururl.com/ClientName

instead of:


Existing Custom URLs for this Survey:

<table>
<thead>
<tr>
<th>Route Name</th>
<th>Route URL</th>
<th>Route Physical File</th>
<th>Route Survey ID</th>
<th>Delete</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

You do not currently have any URL routes.

**URL Shortcut Path Text:**

No spaces, empty values or special characters allowed, this will be used in the URL path. Example:

http://yoururl.com/ClientName

http://yoururl.com/ [Add URL Route]

---

*Email List*

For regular email list deployment, click “Email Lists” and create a new email list.

**Manage Email List**

Enter an email list name, then click “Save”
Create Email List

New Email List Options

Email List Name: Test Email List

- From Scratch -- Create a new Email List from scratch
- From Existing Email List -- Copy an existing Email List

Email List: -- Please Select -- ▼

- Copy all email addresses
- Copy email addresses that match

  Active: -- All -- ▼
  Email Address:
  Custom Data1:
  Custom Data2:
  Custom Data3:

- From Registered Users -- Create an email address list from registered users

  - Copy all registered users
  - Copy registered users that match

    Active: -- All -- ▼
    Email Address:
    Position:
    Company:
    Location:
    Custom Data 1:
    Custom Data 2:
    Custom Data 3:
    Owners: admin;

On the following page you have the option of importing from a file or copy/paste into the comments box provided in the format specified. After this step you can continue to add or remove email addresses from this list from the manage email list page at any time.
To add, edit or remove addresses click the icons in the manage email list page.

You can also export the email list to excel by clicking the “Export” icon.
To view sent messages, click “Messages” icon in the manage email list page.

Below is an example of the message details page:

### Email Message Details

**Message Details**

**Message Subject:** Event Recap 5-28-2014  
**Email List:** Email List for Testing  
**Message Text:**

Dear #firstName#,

We are conducting a survey, and would appreciate your response. The link to the survey is:

#SurveyLink#

Thanks in advance for responding to the survey,

Scott

**CC Emails:**

**BCC Emails:**

**From Email:** tech@classapps.com  
**HTML:** Yes

**Response Count:** 0  
**Sent Count:** 3

**Emails Sent**

Displaying 1 - 3 of 3

Filter by response type: All

<table>
<thead>
<tr>
<th>Email Address</th>
<th>First Name</th>
<th>Last Name</th>
<th>Response Date</th>
<th>Status</th>
<th>Response Count</th>
<th>Sent Date</th>
</tr>
</thead>
<tbody>
<tr>
<td><a href="mailto:briagaelohf@gmail.com">briagaelohf@gmail.com</a></td>
<td>Sheryl</td>
<td>Briggs</td>
<td>No Response</td>
<td>5/27/2014 10:07 PM</td>
<td></td>
<td></td>
</tr>
<tr>
<td>sales@classapps</td>
<td>com</td>
<td>Sales</td>
<td>No Response</td>
<td>5/27/2014 10:07 PM</td>
<td></td>
<td></td>
</tr>
<tr>
<td><a href="mailto:tech@classapps.com">tech@classapps.com</a></td>
<td>Tech</td>
<td></td>
<td>No Response</td>
<td>5/27/2014 10:07 PM</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

sent emails per page
If you are using ResponseLogic, you can view scheduled emails to be sent at a future date and cancel scheduled emails.

To schedule a message, simply select a send date in the future as shown below.

1. **Email List:**
   - The email list selected on the last page. Click back to change the email list.
   - **Survey:**
     - This list was Last Sent on: 5/27/2014 10:07:11 PM With Email Subject: Event Recap 5-28-2014

2. **Send Date:**
   - Enter the date and time that you want the survey emails to be sent on.
   - Example: 09/01/2014

3. **Email Subject:**
   - Enter the name that you want to show that the email is being sent from.

4. **‘From’ Address:**
   - Enter the email address that the email should appear to come from.

5. **Email Text:**
   - Enter the text of your email below. You may include the following tokens, each of which will be replaced, as noted, in the actual email:
     - #SurveyLink - The location of the link to the survey (required) (this is formatted with an anchor tag around it)
     - #SurveyInfo - Information about the survey (optional) (this can be formatted within the anchor tag around the #SurveyLink)
   - For more information, the original text is available on the web page.
**Email List containing survey login/password**

You can populate any of the email address custom fields with the survey username and login you pre-assign to the user and populate that in the survey deployment email.

You can pre-assign those in excel in bulk and import them along with the email addresses all at one time.

<table>
<thead>
<tr>
<th>List Name:</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Email Address:*</td>
<td><a href="mailto:sales@classapps.com">sales@classapps.com</a></td>
</tr>
<tr>
<td>First Name:</td>
<td>Sales</td>
</tr>
<tr>
<td>Last Name:</td>
<td>Person</td>
</tr>
<tr>
<td>Custom Data 1:</td>
<td>username</td>
</tr>
<tr>
<td>Custom Data 2:</td>
<td>password</td>
</tr>
<tr>
<td>Custom Data 3:</td>
<td>office 1</td>
</tr>
<tr>
<td>Active:*</td>
<td>Yes</td>
</tr>
</tbody>
</table>
3rd party email deployment such as Constant Contact

Generic Link: (no individual email list tracking)

If you are using a 3rd party email system, simply copy the survey deploy link from the deploy page and put that link in the email message in the 3rd party system.
Deploy Survey

Send Survey Invitations by Email

To send invitations via the SelectSurvey E mail List Utility Select the Use E mail List button below. Email lists allow you to send a dynamic link to the Survey that offers you the ability to use Data Piping to insert any of the email list data into the survey. If instead you need to deploy a static link via web page, pop up, or want to use your desktop e mail program use the link below based on purpose.

Did my survey ID change?

Specify Custom Survey ID

Only letters and numbers are allowed. NO spaces, punctuation, or XML or HTML characters are allowed which could potentially break the survey link.

9411976

Save Custom Survey ID

Email Link

To send a link to your survey via email, simply copy the link below and paste it into your email.


Web Page, Pop-up, or Email Links

Web Page Link

Unique Individual Link: (with email list tracking)

Alternatively if you want to use unique URLs for each recipient on the email list page choose “Export to Excel” option, then import that list into your 3rd party email program.
Email Message Formatting

When changing the default email message that appears in the box, make note of the below tokens which are updated when the email sends with their associated values from the email list.

The Default message looks like this:

Dear #FirstName#,
We are conducting a survey, and would appreciate your response.
The link to the survey is:
#SurveyLink#
If you do not wish to respond to this survey, please click on the link below to decline:
#DeclineLink#
Thanks in advance for responding to the survey,
Scott

Below are the tokens specific to email messages and opt outs:
#SurveyLink# - The location of the link to the survey (required) (this is formatted with an anchor tag around it)
#SurveyLinkUnformatted# - No anchor tags around the link, so you can put it in an image or tag with your own click link text.
#EIDToken# - Just the EID with nothing around it. Usage Example: yoururl/TakeSurvey.aspx?EID=#EIDToken# #QSStart# - Survey Link query string add on values starting marker.
#QSEnd# - Survey Link query string add on values ending marker.
Example: #SurveyLink##QSStart##product=apple&office=#CustomData1#&country=US#QSEnd#
The above example will automatically attached the extra query string values on to the end of the #SurveyLink# URL anchor tag.

#DeclineLink# - The location of the link a user can click to decline responding to the survey
#DeclineLinkUnformatted# - No anchor tags around the link so you can put it in an image.
#FirstName# - The first name of the email recipient
#LastName# - The last name of the recipient
#CustomData1# - The first custom data field
#CustomData2# - The second custom data field
#CustomData3# - The third custom data field
#OptOutLink# - A link for the user to opt-out of further emails (this is just the link put your own text around it such as "click #OptOutLink# if you no longer wish to receive emails"...
Hidden Fields

Survey Options
Survey Options
‘Test Survey’ Survey
Please make changes in the form below. Note that all fields marked with an asterisk(*) are required.

Hidden Fields
There are no hidden fields configured for this survey. Click the “Configure” button to add fields or to learn more about hidden field to a survey that does not have any responses.

Configure Hidden Fields

Configured Dynamic Tokens
There are no Dynamic Tokens configured for this survey. Click the “Configure” button to add dynamic token or to learn more.

Configure Dynamic Tokens

Survey Review
The survey review feature allows review and edit of a response within a single survey page (instead of having to page through each

Configure Survey Review

Hidden Fields Survey

When a user responds to a survey, you may save data stored in session, cookies, or in the querystring, and have this data be associated with each individual response. The Type field is the source of the hidden data, the Key field is the key within the session, cookie, or querystring used to extract the data, and the Display Name field is how the data captured will be displayed in the reports.

To populate the response with the hidden field in the above case, you must add it to the query string deploy URL like so:


Adding the “&test=123” will store “test” variable to equal “123” for the person that clicks this link.
Dynamic Tokens

You can use dynamic tokens to insert custom data, delete custom data, retrieve custom data, retrieve single values, rows, or data sets, even XML or chart data directly from the database to display in a survey, email or custom report.

To add a dynamic token to a survey, click “Survey Options” then the “Advanced” tab:

![Survey Options](image-url)
### Dynamic Token Piping Query Examples:

#### Dynamic Token ID (DT)

Click the "configure dynamic tokens" button on the survey options page to add dynamic tokens, then type in or use the menu to place the token where ever you want the text replacement to occur. You can use dynamic tokens in insert custom data, delete custom data, retrieve custom data, retrieve single values, rows, or data sets, even XML or chart data directly from the database.

**Dynamic Token Query Example 1:**

```
select title AS results from sur_survey where survey_id = ###100###
```

Just place the dynamic token in the survey by pasting the token that is generated in the application i.e. `###DT=yourtokenname###` into the location in the survey, such as in the question text, subtext, or question itself. You can also place dynamic tokens in custom reports and emails and they will get replaced out with the resulting data when rendered. If the token returns no results and just updates, inserts or deletes data, then it will not display in the survey at all but will process when the question is rendered.

**Dynamic Token Query Example 2:**

```
```

Use these dynamic tokens in your question text or answers to "pipe" this data into your survey.
Dynamic Token Query Example 3: (delete data with a dynamic token in a survey)
delete from Acustom_report2 output " as results where ResponseID NOT IN (select response_id from sur_response)

Dynamic Token Query Example 4: (generate a chart with a dynamic token in a custom report)
select [Product Sold], [Fiber Type], [Backing], SUM([Square Yards Sold]) AS [Square Yards Sold], '$' + convert(varchar(50), cast(round(SUM([Square Yards Sold])*.05),2)) AS [Stewardship Assessment Invoiced], SUM([Square Yards Returned]) AS [Square Yards Returned], '$' + convert(varchar(50), cast(round(SUM([Square Yards Returned])*.05),2)) AS [Stewardship Assessment Returned], SUM([Exempt Assessment Adj]) AS [Exempt Assessment Adjustment - Square Yards], '$' + convert(varchar(50), cast(round(SUM([Exempt Assessment Adj])*.05),2)) AS [Exempt Assessment Adjustment Amount], SUM([Write Off Assessment NC]) AS [Write Off Assessment Non Compliance - Square Yards], '$' + convert(varchar(50), cast(round(SUM([Write Off Assessment Bankrupt])*.05),2)) AS [Write Off Assessment Bankrupt - Square Yards], '$' + convert(varchar(50), cast(round(SUM([Write Off Assessment Bankrupt])*.05),2)) AS [Write off Assessment Bankrupt Amount], SUM([Square Yards Sold]) - SUM([Square Yards Returned]) - (SUM([Square Yards Returned]) + SUM([Write Off Assessment Bankrupt]) - SUM([Write Off Assessment Bankrupt])) AS [Net Sq Yds], '$' + convert(varchar(50), cast(round(SUM([Square Yards Sold])*.05),2)) AS [Stewardship Assessment Due Care] from Acustom_report2 where SurveyID=134 group by [Product Sold], [Fiber Type], [Backing]

Dynamic Token Query Example 5: (generate a chart for custom report)
Select round(sum(CAST((cast(answer_text as nvarchar(max))) as float)) - (Select sum(CAST((cast(answer_text as nvarchar(max))) as float)) from sur_response_answer where item_id in (625, 626, 627, 626, 616, 617, 618, 614, 607, 608, 609, 605, 598, 599, 600, 596, 589, 590, 591, 587, 580, 581, 582, 578, 571, 572, 573, 569, 562, 563, 564, 560, 555, 554, 555, 551, 544, 545, 546, 542, 535, 536, 537, 533, 526, 527, 528, 524, 517, 518, 519, 515, 508, 509, 510, 504)),2) as [Total Sq. Yards] from sur_response_answer where item_id in (633, 624, 615, 606, 597, 588, 579, 570, 561, 552, 543, 534, 525, 516, 505)

Advanced Reporting
The dynamic token above was used in a free form report:
<table>
<thead>
<tr>
<th>Company Name</th>
<th>Response ID</th>
<th>Stewardship Assessment Due Care</th>
<th>Sq. Yards</th>
</tr>
</thead>
<tbody>
<tr>
<td>Alexandria International, Inc.</td>
<td>2471</td>
<td>$2814.74</td>
<td>56294.73</td>
</tr>
<tr>
<td>Alliance Textiles</td>
<td>2489</td>
<td>$1568.08</td>
<td>31361.6</td>
</tr>
<tr>
<td>Atlas Carpet Mills, Inc.</td>
<td>2467</td>
<td>$3699.15</td>
<td>73783</td>
</tr>
<tr>
<td>Beaulieu Group LLC</td>
<td>2485</td>
<td>$89762.10</td>
<td>1795242.02</td>
</tr>
<tr>
<td>BELLBRIDGE, INC</td>
<td>2484</td>
<td>$95.49</td>
<td>1909.72</td>
</tr>
<tr>
<td>Bloomsburg Carpet Industries, Inc.</td>
<td>2465</td>
<td>$441.70</td>
<td>8834.02</td>
</tr>
<tr>
<td>Brintons U.S./Axminster, Inc.</td>
<td>2463</td>
<td>$1151.06</td>
<td>23021.25</td>
</tr>
<tr>
<td>CAP Carpet, Inc.</td>
<td>2472</td>
<td>$8.88</td>
<td>177.66</td>
</tr>
<tr>
<td>Catalina Home</td>
<td>2458</td>
<td>$880.37</td>
<td>13607.31</td>
</tr>
<tr>
<td>CAVALIER CARPET INDUSTRIES</td>
<td>2438</td>
<td>$2403.42</td>
<td>48068.36</td>
</tr>
<tr>
<td>Colin Campbell &amp; Sons Ltd./Nature's Carpet</td>
<td>2462</td>
<td>$26.30</td>
<td>527.65</td>
</tr>
<tr>
<td>COURISTAN, INC.</td>
<td>2482</td>
<td>$1006.34</td>
<td>20126.87</td>
</tr>
<tr>
<td>COURISTAN, INC.</td>
<td>2483</td>
<td>$94.17</td>
<td>1883.36</td>
</tr>
<tr>
<td>Crosseley Axminster Inc.</td>
<td>2474</td>
<td>$54.48</td>
<td>1089.5</td>
</tr>
<tr>
<td>Dalton Carpet Mart</td>
<td>2490</td>
<td>$542.03</td>
<td>10840.51</td>
</tr>
<tr>
<td>DALTONIAN FLOORING INC</td>
<td>2448</td>
<td>$250.78</td>
<td>5215.66</td>
</tr>
<tr>
<td>Design Manufacturing International, LLC</td>
<td>2445</td>
<td>$50.30</td>
<td>1005.97</td>
</tr>
<tr>
<td>Desso USA, Inc.</td>
<td>2469</td>
<td>$27.21</td>
<td>544.18</td>
</tr>
<tr>
<td>DOBBS MILLS LLC</td>
<td>2486</td>
<td>$34230.11</td>
<td>684602.11</td>
</tr>
<tr>
<td>Earth Weave Carpet Mills</td>
<td>2466</td>
<td>$68.19</td>
<td>1363.89</td>
</tr>
<tr>
<td>Emerald Carpets</td>
<td>2481</td>
<td>$3389.06</td>
<td>67781.29</td>
</tr>
<tr>
<td>Engineered Floors, LLC</td>
<td>2456</td>
<td>$3419.73</td>
<td>697804.59</td>
</tr>
</tbody>
</table>

Manage Free-Form Reports
This page allows you to manage free-form reports.
Below you can add, edit or delete free-form Reports.
Viewing Requires a “Report Share” login. When the user clicks the email link they must login to view the report.
To add a login for someone to view a report set their permissions role to “Report Share” only. To add a user, click “Users” then “Add” then make sure you select the “Report Share” role from the drop down box. The email address for the report share recipient must match their login email address, since both must match in order to view the report.
Access Types: “L” = Login Required (Report share login role or higher), “A” = Anonymous

<table>
<thead>
<tr>
<th>Free-Form Report Name</th>
<th>Date Created</th>
<th>Report Share URL</th>
<th>View</th>
<th>PDF</th>
<th>Edit</th>
<th>Delete</th>
<th>Enabled</th>
<th>Report Sharing</th>
<th>Send</th>
<th>Access Type</th>
</tr>
</thead>
</table>

Page 61 of 86
Free Form Auto-PDF Population mapping into Acro Fields

Individual responses can be exported into PDF’s where each answer is mapped to a PDF acro field. Just upload your PDF using the upload utility provided, then use the mapping menu to map each survey question to the PDF Acro field. When the responses come in, each response will have a PDF link, clicking the PDF link will populate the PDF with that response.

First click “Create Free Form Report”,
Select or upload the pre-existing PDF into SelectSurvey.NET using the upload button, or select from prior uploaded PDF’s in the drop down box.
Free-Form Reports

Edit Free-Form Report

Select from the below questions to include in the report.

Manage Filters

Below you can design your own free-form report with the html editor using the tokens provided which will provide text replaceable cumulative 360 style reports. This is a report of cumulative responses for calculating totals per question. This report is not cumulative in nature, use the Custom Report for individual response display.

Access Type:
Select the access level required to view the report. All report shares utilize unique URL link, so report views are not shared unless set to "Public" in Access Type.

Anonymous

Report Name
Final Event Recap PDF report 6-9-2014

Current PDF Template:
That will be autofilled by the individual results.
StudioEventRecap-6-9-2014.pdf

<table>
<thead>
<tr>
<th>PDF Field Key</th>
<th>PDF Field Type Name</th>
<th>Question Answer Mapping</th>
<th>Column</th>
<th>Row</th>
<th>Col Attr</th>
<th>EDIT</th>
</tr>
</thead>
<tbody>
<tr>
<td>Brand</td>
<td>TextField</td>
<td>104</td>
<td>-1</td>
<td>-1</td>
<td>0</td>
<td>E/E</td>
</tr>
<tr>
<td>Address</td>
<td>TextField</td>
<td>233</td>
<td>-1</td>
<td>-1</td>
<td>0</td>
<td>E/E</td>
</tr>
<tr>
<td>Account</td>
<td>TextField</td>
<td>425</td>
<td>-1</td>
<td>-1</td>
<td>0</td>
<td>E/E</td>
</tr>
<tr>
<td>Start Time</td>
<td>TextField</td>
<td>350</td>
<td>-1</td>
<td>-1</td>
<td>0</td>
<td>E/E</td>
</tr>
<tr>
<td>End Time</td>
<td>TextField</td>
<td>375</td>
<td>416</td>
<td>-1</td>
<td>0</td>
<td>E/E</td>
</tr>
<tr>
<td>Duration</td>
<td>TextField</td>
<td>238</td>
<td>-1</td>
<td>-1</td>
<td>0</td>
<td>E/E</td>
</tr>
</tbody>
</table>

Click "Edit" for the acro field mapping menu to map questions to acrobat fields

If you update the PDF, click "Rescan"

To view individual responses populated into each PDF, click the “View” or “PDF” icons below.
After clicking “PDF”, the individual response is populated into the PDF form, similar to the below example:

Images and digital signature question types in survey are mapped to acro text boxes:
Application Wide Settings Options

Click “Admin Tools” link in upper right corner, then “Application Wide Settings” link. Here you will find the application wide settings such as “Default Survey Template”, “Default Days Survey is Open”, which when set are the defaults for all new surveys created from scratch.
Archiving and Restoring Surveys from Archive Database

A new feature with 5 is that the archive database is completely separate from the production database. This enables the application to run faster, so you can offload legacy surveys and responses for better performance. If you have ten years of surveys and responses, the application will begin to bog down if you are not updating your memory and hardware to compensate for the extra space, and your database could grow to well over 100 gig.
To remedy this situation, a new “archive and restore” feature is available for all users from the survey list page.

When you click “archive” to the right of a survey name, it will copy that survey into the separate “archive” database and remove it from your production database entirely. The survey will not longer show in the survey list.

In order to “restore” the survey at a later date, you would click “restore survey” button at the top right of the survey list page as shown in the screenshot below:

![Screenshot showing the restore survey page](image.png)

After you click the button, it will take you to a restore survey page, where you can select the name of the survey you wish to restore from a drop down box as shown in the screenshot below:
After you select the survey name from the drop down box, then click “Restore Survey” button. A message will show in red text when it is completed. After it is completed restoring, the survey name will show up in the survey list page again.

Admin Tools

First, login using and admin account.
Second, click “Admin Tools” link from the user profile menu as shown below.
Below are the various tools you will have access to:

- Account Usage
- General Configuration
- Application Wide Settings
- Database Tokens (Nicknames) used in Dynamic Tokens and Database Question Types
- Web Service/ API Tokens used in Dynamic Tokens and Database Question Types
- Debug Database Connection
- Database Version
- View Logs, Clear Logs
- Database Validation Tool for Surveys
- Database Validation Tool for Libraries
- Data Copy Utility
- User Data Copy Utility
- Delete Report Filters
- Debug Install SMTP Settings – Send Test Email
- Decrypt EID Link or SurveyID
- Specify Company Logo and Copyright Text
• Globalization and Custom Text
• Translate / Edit Global Text
• Translate / Edit Admin Area Text
• Debug International Date Formats
• Unlock Surveys
• Kiosk Admin
• XML Generator Admin
• View Uploaded Images/Files – Upload Image/File
• Activate / De-Activate Question Types
• Active Directory User Field Synchronization Mapping

Kiosk Admin

Kiosk Mode is a mode which activates a Kiosk page, which is mostly useful in a kiosk/touchscreen – such as a computer/laptop/touchscreen located in a public place, or used by a sales person in a convention. In this situation, there typically would be a full screen survey page with a button to take the survey. When the respondent walks up to the kiosk they click the button – to start the survey. If configured for a sales person – the sales person can enter the users info, or look up the users info and click a button to login as them and answer the questions as the respondent. In this case you would activate the user lookup/registration feature to display on the Kiosk Home page so the sales person could look up/add respondent information. Alternatively this functionality can be hidden and just have a single anonymous take survey button for each survey activated.

Kiosk Mode is activated on a “per survey” basis, where each survey must be added to the kiosk from the “admin tools” (for security).

To activate Kiosk Admin Home Page, go to “admin tools” > (scroll down to) “Kiosk Admin” > then you will be on the Kiosk Admin page.
From the Kiosk Admin Page, follow the below steps to activate and setup a survey to show on the Kiosk Home page:

1. Copy the Kiosk home page URL for your reference where it says “Activate Kiosk Home Page at:”
2. Click the “Activate Kiosk Home page” checkbox
3. Change the Logo path to your logo on the Kiosk Admin page.
4. Select the survey from the drop down box “Kiosk Surveys”
5. Click the button “add survey to kiosk”
6. Click “save” at bottom of page.
7. Test the URL that you copied from #1 above.
After you configure the Kiosk home page you go to the URL – make the browser full screen, such as below:


this is the URL you will open full screen on KIOSK

Kiosk Surveys:
Add or remove surveys that will be available on the Kiosk Home page.

Demo 3-14-2017

Remove from Kiosk
   Survey Title
   Demo 3-14-2017
   Remove From Kiosk

Display User Registration:
Enter the survey deployment url of the survey you have created that contains the user registration question type. Copy the survey deployment link from the deploy page for the registration survey.

Display User Registration On Kiosk Home Page

User Registration Survey Deploy URL:
Enter the survey deployment url of the survey you have created that contains the user registration question type. Copy the survey deployment link from the deploy page for the registration survey.

You can change the logo, and look and feel of the page. The search portion will not display if you have not activated the “Display User Registration” box.

When checking the “Display User Registration” box, you must create your desired user registration survey using the “user registration” question type, and copy the deploy URL into the box on the Kiosk Admin page.

**User Reviewers for User Workspace and Approve/Review**

Reviewer to User Mapping

Apply to:

- User Workspace
- Analyze > Approve/Review
Users can be mapped into roles of reviewers for the review/approval process features built into the User Workspace of SelectSurvey.NET. Once a user is set as a reviewer, they can approve or reject survey responses in the user workspace for those they review for, and can approve/review via the analysis pages as well and submit comments below each question on the survey that can only be hidden for admin, or comments back to the respondent for further response updates.

Click “Users” > “Reviewer Map” to view the list of existing user reviewers.

Then click “Create User to Reviewer Mapping” to map a user or user group to a reviewer role.

Below is the screen to map a reviewer to a user. That means the reviewer has permission to see, comment on and approve/reject any response for that user in the user workspace, or in the approve/review screens.

The built in review levels for a three tier review are below:

- Level 1 Reviewer
- Level 2 Reviewer
- Level 3 - Legal Reviewer

Level 2 and 3 are not required. You can use a single review tier for simplicity.

After you add a reviewer they will show in the list:

**User Workspace**

The user workspace is a portal for respondents, that shows a list of surveys that the user has been “invited” to take.
Reviewers are NOT required for the user workspace, but if reviewers are set up, they will see the user’s survey list for those users that they are mapped to “review” for.

**How to Enable the User Workspace Feature:**

If you do not see the user workspace tab in the SelectSurvey.NET interface, then you need to enable the feature in admin tools by following the below steps:

- Login as an admin user
- Go to “Admin Tools” > “Application Wide Settings”
- Scroll down to “Feature Defaults” section > “Activate User Workspace” > change drop down to yes, click save.

**How to Enable a survey to show in the User Workspace:**

On the survey options page for the survey, click the checkbox that says “Show in User Workspace” as shown in the screen below:
How to Enable a specific user or user group to see a survey in their User Workspace:

By default, if a survey is enabled for user workspace, all users with a login will see it in their user workspace. If the survey has a user group restriction, then only the users in the user group will see the survey in the user workspace.

On the survey options > Access tab, add specific users to the user group restrictions, or AD user group restrictions for the survey.

What the User Sees:
How to White Label/Brand the User Workspace:

You can change the look and feel of the User Workspace page that respondents see.

To customize the look and feel of the page follow the below steps:

- Login as an admin user
- Click “admin tools” > “White Label Branding” > “Specify Company Logo, Footer Text, Login Stylesheet, User Workspace Template”
3rd Party API Integration:

Workfront Project API – Push Survey Data into new Project Issues

When someone completes a survey, it can automatically push the survey answer data into Workfront Project creating a new “Issue” in an existing “Project” in Workfront Project.

You can accomplish this with the built in interface inside SelectSurvey with no programming!

Below are the steps and screenshots to accomplish a data push of survey data to Workfront.

The first step is to setup a Web Service Token in “admin tools” that contains the URL, username and password to access the web service or 3rd party API.

Add web service token:

Click “Admin Tools” > “Web Service/API Tokens used in Dynamic Tokens and Database Question Types”.

Click “Create Web Service Token” as shown in above screenshot.

Enter the username, password and URL in the screen shown below, then click “Save”.

Click here to select or deselect all web service tokens.
Now you can setup the Workfront Project Mapping Integration:

1) On the Survey List page, click “Survey Options” icon next to the survey that you want to push data to Workfront Project:

2) Click the “API” tab on the Survey Options page.

3) Click the “Workfront Project API Configuration” link
4) Click “Add” after selecting the Workfront Project API from the drop down box, entering a name for the mapping, and select whether it is enabled or disabled.

5) Click “Add” to select survey questions to map to workfront project issue custom fields:
6) Click “Save” on the pop up after selecting the question and entering the custom field into the text box.

7) Test the mapping.

To Edit the mapping:

1) Click the “Edit” button to the right of the mapping and a pop up will display to edit that row's information.
SalesForce API
SalesForce API Integration is coming soon.

SugarCRM API
SugarCRM API Integration is coming soon.
Obtaining Technical Support Resources

General Technical Support Requests

General Technical Support can be obtained by any of the below methods:

- By Email to tech@classapps.com
- By calling 800-774-4876 (Press 2 to go directly to technical support). Note that if all tech support people are on the phone, that your voice mail will be transcribed and emailed to all tech support staff, and can be answered while they are on other calls, so please leave a message for the fastest response. Also note that only “Level 2” support includes phone support. All other levels include email support only.

When contacting technical support, you will need to provide the below:

- **Customer ID Number (Login):** _ _ _ _ _ _

The customer ID number and password is assigned and emailed to client upon purchase. The customer ID and password above is used to access product updates, product downloads, renew support, print receipts, print estimates, access to license keys.

Other information on the technical support ticket might include:

- **SelectSurvey.NET Version Number:** v_ _ _ _ _ _ _ _

The database version number is found in the footer of every page in SelectSurvey.NET application.

- **Database Type:** _ _ _ _ _ _ _ _ _ _

Supported database types are MS SQL (2005 or later), Oracle (10 or later), or MySQL (6 or later).

- **IIS Version:** _ _

Supported IIS Versions are iis 6, iis 7, iis 7.5 or greater.

Installation Service/Upgrade Service/Consulting Request

To obtain an estimate for installation service, upgrade service or consulting by the hour for survey design, custom reports or programming custom features, contact sales@classapps.com or call 800-774-4876 (press 1 for sales).
Installation Service and Upgrade Service are available for a per instance fee. Currently that fee is $150 USD. That covers a technical support person that would RDP into the server to update the files in IIS, set permissions on survey folder, and run a database script. The installation service only covers installing the application, and does not include DNS setup, MS SQL install, IIS install or general server setup or network setup.

Consulting is available by the hour, programming and survey design consulting is available, as well as anything above and beyond a normal installation/upgrade service.

**Support Knowledgebase**

SelectSurvey.NET has a public helpdesk that you can search for common issues. You can access the knowledgebase from here:  [http://www.classapps.com/helpdesk/categorized.asp](http://www.classapps.com/helpdesk/categorized.asp) Click “Search” to search for a keyword.

**Support Documentation/Videos**

All documentation is linked from the ClassApps.com website as well as included in the product download zip file in the "documentation" folder.


Videos demonstrating features and installation are located here:


The general support page that links all support related links is located here:


**Product Updates / Critical Security Warnings**

Product updates occur each month due to new features, and updates required from new browser releases, or new mobile device releases. Some updates are also required due to security issues that might arise due to vulnerabilities in windows servers, browsers, or other related technology issues.

It is very important to stay aware of any critical security issues or product updates. The way to do this is to sign up for the SelectSurvey.NET RSS feed, or follow the SelectSurvey Twitter or Facebook page. All of these 3 communication channels update automatically any time we make a release. The release summary is posted to each of these sites simultaneously. The full release notes are included in the product download zip, and critical security concerns are only visible from the client login area after logging in. If there is a critical security issue, we post that there is a
critical security issue, and the details of the risk and instructions will be posted in the client login area to minimize risks to client installs.

Product updates can be obtained from any of the following methods:

- RSS Feed: (http://classapps.com/rss/SelectSurveyupdates.asp) to add the RSS feed click the RSS Feed button here:  http://www.classapps.com/Support.asp
- Twitter:  http://twitter.com/SelectSurveyNET
- Facebook:  http://www.facebook.com/SelectSurvey.NET